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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Some application pages have help icons    to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
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https://www.oracle.com/education/
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https://community.oracle.com/customerconnect/categories/idealab-guidelines
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1  Questions and Answers

How do I manage Self-Service users?  
Users can be granted different roles. By default, when a registration request is approved for a user, they are granted the
User role. However, administrators can grant or remove roles, depending on the user's intended responsibilities.

Note:  The first user to be approved for a customer account is automatically granted the Account Administrator role.
There must always be one user with the Account Administrator role for an account.

Use this topic to add and remove roles for self-service users in Oracle Fusion Service. For more information about self-
service user roles, see About Digital Customer Service Roles.

To manage self-service roles for an account:

1. Sign in as a user with the Customer Self-Service Administrator role.
2. Navigate to the Service work area and click Self-Service Users.
3. From the Self-Service Users list, select the user you want to modify.
4. In the User Administration section, select or deselect one or more of the following roles:

◦ User

◦ Account Manager

◦ Account Administrator

Note:  Removing the User role causes the removal of all privileges. The only way to restore the privileges is to
submit a new registration request. Only a user with the SVC_DELETE_LAST_ACCOUNT_ADMIN_ROLE_PRIV
privilege can delete the user role for the last Account Administrator. Users with the Customer Self-Service
Administration role have the SVC_DELETE_LAST_ACCOUNT_ADMIN_ROLE_PRIV privilege by default. The
last account administrator can only be deleted using the selfServiceRoles REST API.

5. Click Save.

A dialog appears, confirming the role modifications.

How do I configure DCS profile options?  
This topic describes Digital Customer Service profile options, including configuration instructions.

The following two task lists apply to profile options for Digital Customer Service:

• Manage Digital Customer Service Profile Options

• Manage Digital Customer Service Account Setup Profile Options
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Overview of Profile Options
Profile options let you configure and control application data centrally. Administrators and setup users manage profile
options in the Setup and Maintenance work area.

Profile options store various kinds of information, including the following:

• User preferences

• Installation information

• Configuration choices

• Processing options

Here we focus on Oracle Fusion Service profile options specific to Digital Customer Service.

Registration Profile Options
The following table lists the profile options for Digital Customer Service Registration Profile Options.

Profile Option Default Value Possible Values Effect

SVC_CSS_SELF_REGISTRATION
 

New Or Existing
 

None
 
New Or Existing
 
Existing Only
 

Specifies which contacts can self-
register. If Existing is specified,
only existing contacts can self-
register.
 

SVC_CSS_SELF_REG_AUTO_
APPROVE
 

False
 

True
 
False
 

Enables automatic approval of self-
service registration requests that
are associated with an account.
 
If SVC_ CSS_ SELF_ REG_AUTO_
APPROVE is set to False and SVC_
 CSS_ ACCT_ADMIN_APPROVE
is set to True, then the Digital
Customer Service Account
Administrators can approve user
registration requests in the Digital
Customer Service Customer user
interface. Also, Digital Customer
Service Administrators can approve
registration requests in the Digital
Customer Service Administration
user interface.
 

SVC_CSS_ACCT_ADMIN_APPROVE
 

True
 

True
 
False
 

Enables the approval of self-service
user registration requests by users
with Digital Customer Service
Account Administrator roles.
 
If set to True, Digital Customer
Service Account Administrators
can approve user registration
requests in the Digital Customer
Service customer user interface
and Digital Customer Service
Administrators can approve
registration requests in the Digital
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Profile Option Default Value Possible Values Effect

Customer Service Administration
user interface.
 
If set to False, only Digital
Customer Service Administrators
can approve registration requests
in the Digital Customer Service
Administration user interface.
 

Note:
This option applies only when
the SVC_ CSS_ SELF_ REG_
AUTO_APPROVE option is set to
False.
 

SVC_CSS_ACCT_KEY_FIELD
 

OrganizationName
 

Any field in the Account object
 

Specifies a valid field name in the
Account object. The field name is
case sensitive.
 

Note:
You must create an attribute
in the account object to be the
account key, because the default
account key of account name
isn't secure.
 

SVC_CSS_REG_CONT_MAP
 

An empty string
 

An empty string.
 
Any defined value, with a colon
separating fields, and commas
separating the pairs.
 
For example, reg_field1:contact_
field1, reg_field2:contact_field2
 

You specify a value for this profile
option only if the name of the
attribute in the Self Registration
object is different from the name
in the Contact object. Cases where
they may happen are if you have
created a custom attribute for
an object. Custom attributes
are designated with an _c, such
as PlaceOfBirth_c. For this use
case, you ignore the _c when
determining whether an attribute
maps or not.
 
So, let's take the custom attribute
in the Self Registration object
PlaceOfBirth_c. Since the
Contact object has a out of the box
attribute called PlaceOfBirthno
mapping is required since the
two values match. If, however,
 the name of the custom attribute
was BirthPlace_c the value of
this profile option would then be
BirthPlace_c:PlaceOfBirth.
 
Here's a additional example with
multiple mappings:
 
First, you specify case sensitive
name and value pairs to map
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Profile Option Default Value Possible Values Effect

the fields of the Registration
View object to the Contact View
object in the following way: reg_
field1:contact_field1,reg_
field2:contact_field2.
 
The reg_field1 is the
PlaceOfBirth_c in the Registration
View Object which is a custom
object created in Application
Composer.
 
The contact_field is the
PlaceOfBirth field in the Contact
View object. This attribute is
already present in the Contact
object.
 
So the mapping would be:
 
reg_field1:contact_
field1 LIKE BirthPlace_
c:PlaceOfBirth
 

SVC_CSS_SIGN_IN_ATTR_NAME
 

EmailAddress
 

The value of the assigned attribute
must be unique.
 
Possible values include:
 
EmailAddress
 
 

Specifies the sign-in attribute
that users must specify in the
Login ID field in the Self-Service
Registration object. This field is
used to determine whether the
user exists in the Lightweight
Directory Access Protocol server.
 

SVC_CSS_REG_FLD_CONTACT
 

EmailAddress
 

Any field on the Self-Service
Registration object.
 

Specifies the field to use during
the user registration process to
determine if the registering user
is an existing contact. The field
names are case sensitive.
 
The SVC_CSS_REG_CONT_MAP
profile option is used to locate
the name of the attribute on the
Contact.
 

SVC_CSS_SEND_WELCOME_EMAIL
 

True
 

True
 
False
 

Enables sending a welcome
email when a new user account is
created.
 

SVC_CSS_USER_ROLE_COMMON_
NAME
 

ORA_SVC_CUSTOMER_SELF_
SERVICE_ USER_ABSTRACT
 

A string representing the name of
the role that's set up for Customer
Self-Service users. Typically, this is
a copy of a Customer Self-Service
User with additional privileges
added.
 
 

Specifies the common name of the
role granted to previously created
Customer Self-Service Users.
 

SVC_CSS_ACCT_ADMIN_ROLE_
COMMON_NAME
 

ORA_SVC_CUSTOMER_
SELF_SERVICE_ ACCOUNT_
ADMINISTRATOR_ABSTRACT

A string representing the name
of the role that's set up for
Customer Self-Service Account

Specifies the common name of
the role granted to the previously
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Profile Option Default Value Possible Values Effect

 Administrator. Typically, this is a
copy of a Customer Self-Service
Account Administrator with
additional privileges added.
 
 

created Customer Self-Service
Account Administrators.
 

SVC_CSS_USER_CATEGORY
 

An empty string
 

A string
 

Specifies the user category that
defines the URL to which the self-
service user is redirected after a
password reset.
 
The user category is defined in the
Security Console.
 

SVC_CSS_IMP_SIGN_IN_ATTR_
NAME
 

PrimaryEmailAddress
 

Any field on the Contact object.
 

Specifies a field in the Contact
object to be used as the sign-in
attribute when importing data into
the Self-Service Roles object. The
field name is case sensitive.
 

SVC_CSS_USE_FA_AS_IDP
 

False
 

True
 
False
 

Specifies whether the identity
provider is Oracle Fusion
Applications or Oracle Identity
Cloud Service.
 
When set to True, Oracle Fusion
Applications is used.
 

ORA_SVC_CSS_SELF_REG_B2C_
AUTO_APPROVE
 

True
 

True
 
False
 

Enables automatic approval of self-
service registration requests that
aren't associated with an account.
 
If set to True, users who register
without an account will be auto
approved to become self-service
users. If set to False, users who
register without an account
will need to be approved by an
administrator before they can
become self-service users.
 

SVC_CSS_PUDS_CACHE_
DURATION
 

15
 

Integer in minutes
 

Determine the amount of time,
in minutes, that Self-Service
Optimization objects are cached.
 

SVC_CSS_ALLOW_CONTACT
 

True
 

True
 
False
 

Enables the self-service
registration of B2C Service
contacts.
 

SVC_CSS_ALLOW_CONSUMER
 

True
 

True
 
False
 

Enables the self-service
registration of consumers.
 

SVC_CSS_CONSUMER_USER_
CATEGORY

An empty string
 

A string
 

Specify the user category for
consumers defining the redirect
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Profile Option Default Value Possible Values Effect

 URL for self-service users after a
password reset.
 

Account Setup Profile Options
The following table lists the profile options for Digital Customer Service Account Setup Profile Options.

Profile Option Default Value Possible Values Effect

CSO_CONTENT_RATING_TYPE
 

None
 

True and False
 

Enables content rating for
Knowledge.
 

Set Digital Customer Service Profile Options
This topic describes how to set profile options for Digital Customer Service. The profile options specific to Digital
Customer Service are found in two task areas: Manage Digital Customer Service Profile Options and Manage Digital
Customer Service Account Setup Profile Options.

To find and set the Digital Customer Service profile options:

1. Sign in to Oracle Fusion Service as administrator or a setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Digital Customer Service

◦ Task: Manage Digital Customer Service Profile Options

or

◦ Task: Manage Digital Customer Service Account Setup Profile Options

3. Click the name of the profile option that you want to modify.
4. Set the profile option value as needed.
5. Click Save and Close.

What's the Digital Customer Service design time and
runtime architecture?  
Oracle Digital Customer Service is an offering within Oracle Fusion Service that lets you provide your customer account
users self-service access to their service requests and relevant knowledge articles through a web interface.

You can configure the Digital Customer Service application user interface to reflect a company brand. Using Oracle
Visual Builder, you define root pages and styles, and include various UI components, depending on your business
needs.
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Note:  To use Chat inlays in Oracle Fusion Service, you must configure some profile options. For more information,
see "Configure Chat Inlay" in Oracle Fusion Service Implementing Digital Customer Service.

Once configured and deployed, your customers can self-serve through the application and search for knowledge
articles to solve their problems. Also, your customers can register as Digital Customer Service self-service users so they
can interact with your customer service representatives through service requests, work orders, or by chatting.

Here are general overviews of the design time and of the runtime architecture. The Digital Customer Service application
relies on the following APIs:

• crmRestApi. Provides the connection to Fusion Service.

• fscmRestApi. Provides the connection to the Oracle Application Cloud topology manager and functional setup.

• idcsRestApi. Provides the connection to Oracle Identity Cloud Service.

• knowledge-service. Provides the connection to knowledge content and search.

• attachmentDocTrackerRestApi. Used by the file attachment upload mechanism.

• attachmentUploadRestApi. Used by the file attachment upload mechanism.

• kmRestApi. Used to access the Knowledge Management v2 REST API

• utilityRestApi. Used by ODCS Knowledge Attachment download mechanism.

At design time, when developing a Digital Customer Service application, the developer logs into Oracle Identity Cloud
Service to access the Visual Builder Designer and selects available application templates and components from the
Component Exchange. The source code for the application can be maintained in a Git repository provided through the
Visual Builder Studio (formerly known as Developer Cloud Service). The application is built to interact with various REST
services from the associated Fusion Service instance. Here's a look at the design time architecture:
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At runtime, a self service user interacts with the Digital Customer Service application that's served up from the Visual
Builder runtime environment, and can make requests for a self-service account that's created for the user on Oracle
Identity Cloud Service. The user can then sign in to Oracle Identity Cloud Service to get authenticated access to the
application and use the full functionality of the application enabled by the various REST services from Fusion Service.
The application might also expose Chat functionality. Here's a look at the runtime architecture:
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How do I Import Self-Service users?  
This topic shows you how to import self-service users for use with your Digital Customer Service application.

Use cases for import include when you're migrating from one service implementation solution to Digital Customer
Service, or when you've a new customer account and have been supplied with a list of authorized users.

If you're migrating from another service implementation to Digital Customer Service, you might have some existing
reference identifiers that you'll want to retain from the originating service implementation. In this particular case, the
following fields might help: AccountPartyNumber from the accounts, ContactPartyNumber from the contacts.

First you must create a contact. Once you've created the contact, you've two choices: you can use the Contact Party ID
or Contact Party number. When contacts are created or imported, the contact party ID is automatically assigned. You
can explicitly specify the Contact Party number. If you choose not to specify the Contact Party number, a number will be
automatically assigned.

Accounts are handled in much the same way. An Account Party ID is automatically assigned, and you can choose to
specify an Account Party number or have one automatically assigned.

9
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Finally, there's a primary key for the imported data set. The value of the primary key column is automatically generated
in the Oracle Fusion Applications data model.

Here's a high level overview of what you'll be doing when importing self-service users:

• Creating contacts

• Downloading the Self-Service Roles template.

• Preparing the Import file, then importing the users.

• Sending pending LDAP requests.

Note:  When using the import process for creating self-service users, there's no other approval step required.

Create Contacts
Your first step is to create the contacts. The contact must have an email address. To create contacts, follow the
instructions in the Import Your Contact Data task in the Related Topics list. This might also require you do the Import
Your Account Data task, which is also in the Related Topics list, if you haven't already done that yet.

Download the Self-Service Role Template
This section describes how to download the self-service roles template.

The Self-Service roles template contains the following fields:

Field Usage

AccountPartyId
 

A required field if the AccountPartyNumber value isn't specified. Don't provide this value for B2C.
 

AccountPartyNumber
 

A required field if the AccountPartyId value isn't specified. Don't provide this value for B2C.
 

ContactPartyId
 

A required field if the ContactPartyNumber value isn't specified.
 

ContactPartyNumber
 

A required field if the ContactPartyId value isn't specified.
 

LoginId
 

An optional field. If a value isn't specified its assigned the value of a Contact attribute specified by the
SVC_CSS_IMP_SIGN_IN_ATTR_NAME profile option. The default value for this profile option is Email
Address.
 

RelationshipTypeCd
 

A required field. The following values can be assigned:
 

• ORA_CSS_USER. This corresponds to the Digital Customer Service User role.

• ORA_CSS_ACC_MGR. This corresponds to the Digital Customer Service Account Manager role.

• ORA_CSS_ACC_ADMIN. This corresponds to the Digital Customer Service Account Administrator
role.

RequestTypeCd
 

A required field for B2C. An optional field for Fusion. The following values can be assigned:
 

• ORA_CSS_REQ_TYPE_CONTACT. This Fusion Service value corresponds to the Fusion Contact.

10
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Field Usage

• ORA_CSS_REQ_TYPE_CONSUMER. This B2C Service value that corresponds to the B2C Consumer.

RoleId
 

An optional field. You can remove from the first row of the file.
 

To download the Self-Service roles template file:

1. Sign in to Oracle Fusion Service as an administrator or a setup user.
2. From the Navigator menu, expand Tools, and then select Import Management.
3. In the Manage Imports work area, click the Import Objects tab, and select Search.
4. In the Import Object Details page, enter Self-Service Role in the Display Name search box.
5. Click Download and then save the .zip file to a convenient directory.

Prepare the Import File
This section describes how to prepare the import file for importing self-service users.

Note:  When users are imported into multiple accounts the data should be sorted by account party ID. This maximizes
the possibility of the one thread handling users of the same account and minimize the possibility of deadlocks
occurring due to different threads changing the same account. If all the users belong to the same account, then its
recommended that you use Oracle Integration Cloud integration and retry the logic for handling account row lock
exception.

To prepare the import file:

1. Find, and open the Self-Service Role_Templates<date>.zip file that you saved in the Download the Self-
Service Role Template topic.

2. Extract, then open the SelfServiceRole.csv file.
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3. For each self-service user you plan to import, enter the following data in a dedicated row:

a. Enter the account information relating to the self-service user in the AccountPartyId or
AccountPartyNumber column.

Note:  The Account ID value isn't needed for B2C Service requests.

Tip:  To quickly find the values for AccountPartyId or AccountPartyNumber using REST API, run the
following command as an administrator:

GET <Oracle-Fusion-Application-Host>/crmRestApi/resources/11.13.18.05/accounts/

b. Enter the contact information relating to the self-service user in the ContactPartyId or
ContactPartyNumber column.

Note:  When importing the Contacts, it's possible to provide a unique identifier for each contact in the
form of the ContactPartyNumber. This must be unique for each user. So you should provide the same
unique numbers for ContactPartyNumber for the user in the Contact import file and the Self-Service
Roles import file to match them up.

c. Enter the ID relating to the self-service user in the LoginId column.

Note:  If the SVC_CSS_IMP_SIGN_IN_ATTR_NAME profile option is set, then the LoginId is optional.

d. Enter the Digital Customer Service roles to assign to the self-service user in the RelationshipTypeCd
column. The following values can be assigned:

- ORA_CSS_USER. This corresponds to the Digital Customer Service User role.
- ORA_CSS_ACC_MGR. This corresponds to the Digital Customer Service Account Manager role.
- ORA_CSS_ACC_ADMIN. This corresponds to the Digital Customer Service Account Administrator role.

Note:  The ORA_CSS_ACC_MGR and ORA_CSS_ACC_ADMIN roles by themselves can be only used
if the self-service user already exists. If the import is going to create a new self-service user the
ORA_CSS_ACC_MGR and ORA_CSS_ACC_ADMIN roles must be combined with ORA_CSS_USE
role. To assign multiple roles to a user concatenate them using the & character. For example:
ORA_CSS_USER&ORA_CSS_ACC_ADMIN.

e. Enter the Digital Customer Service roles to assign to the self-service user in the RequestTypeCd column.
If a value isn't supplied the default is ORA_CSS_REQ_TYPE_CONTACT.

The following values can be assigned:

- ORA_CSS_REQ_TYPE_CONTACT. This value is for Fusion Service instances and corresponds to the Fusion
Contact.

- ORA_CSS_REQ_TYPE_CONSUMER. This value is for B2C Service instances and corresponds to the B2C
Consumer. B2C is general public.

4. Repeat step 4, on a dedicated row for each more self-service user you want to import.

Note:  For each AccountPartyId or AccountPartyNumber, at least one user in the import file must have the
ORA_CSS_ACC_ADMIN role assigned.

5. Save the SelfServiceRole.csv file.
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6. Include the SelfServiceRole.csv in a new Self-Service Role_Templates<date>.zip archive, and save it.

Tip:  When using a Mac, you must the zip utility in terminal to create the Self-Service
Role_Templates<date>.zip file.

Consider the following sample data in the SelfServiceRole.csv file:

Example 1: Using Party IDs for import

AccountPartyId,ContactPartyId,RelationshipTypeCd
300100110957452,300100156316610,ORA_CSS_User & ORA_CSS_ACC_ADMIN

Example 2: Using Party numbers for import

AccountPartyNumber,ContactPartyNumber,RelationshipTypeCd 
CDRM_67617,CDRM_743628,ORA_CSS_USER 
CDRM_67617,CDRM_743711,ORA_CSS_USER&ORA_CSS_ACC_ADMIN 
CDRM_67617,CDRM_743651,ORA_CSS_USER&ORA_CSS_ACC_MGR

Example 3: The Login ID explicitly used

AccountPartyNum,ContactPartyNum,LoginId,RelationshipTypeCd 
CDRM_67617,CDRM_743628,Mary.Smith,ORA_CSS_USER 
CDRM_67617,CDRM_743711,John.Rogers,ORA_CSS_USER&ORA_CSS_ACC_ADMIN 
CDRM_67617,CDRM_743651,Pat.Williams,ORA_CSS_USER&ORA_CSS_ACC_MGR

Example 4: B2C

ContactPartyNum,RelationshipTypeCd, RequestTypeCd
CDRM_943831,ORA_CSS_USER, ORA_CSS_REQ_TYPE_CONSUMER
CDRM_943832,ORA_CSS_USER, ORA_CSS_REQ_TYPE_CONSUMER

Import the Self-Service Users
Before proceeding with the instructions in this section, you must have completed the steps in the previous sections:

• Downloading the Self-Service Roles Template

• Preparing the Import File

Note:  For best performance set the value of profile option ZCA_STANDARD_IMPORT_COMMIT_SIZE to 1. If
SVC_CSS_USE_FA_AS_IDP is enabled (set to TRUE) you must set the ZCA_STANDARD_IMPORT_COMMIT_SIZE value to 1. This
must be done for the following reasons. The default value for commit size is 100. This value also influences the retry
logic built into the import framework. An error in any one import row will cause the entire batch to roll back. For self-
service import when IDCS is the IDP, the impact of rollback is severe because many users determined by the commit
size have been created and needs to be rolled back. With retry the impact is even more severe because there could
be more than 1 rollback for the same batch causing the import process to slow down considerably.

To import the self-service users:

1. Sign in to Oracle Fusion Service as an administrator or a setup user.
2. From the Navigator menu, expand Tools, and then select Import Management.
3. In the Manage Imports work area, click the Create Import Activity button.
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4. In the Create Import Activity workspace, enter the following import options:

a. In the required Name field, enter a name for the import activity.
b. In the optional Description field, enter a description of the import activity.
c. Click the Object drop-down list, and search for Self-Service Role.
d. Click the File Name Browse button and find the SelfServiceRole.csv file you downloaded.

5. Click Next.
6. Verify the mappings are as expected. If necessary, make your corrections.
7. Click Validate Data.
8. Click Next.

The Create Import Activity: Review and Submit screen is displayed.
9. Click the Submit button.

Your import job is listed in the Manage Import Activities list. The Status value of your job will change multiple
times during processing, until it's Completed or Completed with Errors.

10. From the Manage Imports workspace, click the My Completed Imports tile and select the link for your import
from the list and review the import details.

11. (Optional) Review errors. If the Status value is Completed with Errors, some users might not have been
imported. Follow these steps to review the errors:

a. On the Import Status workspace, click the Actions menu and select Generate Diagnostics.
b. Download the generated zip file, to review the diagnostic messages .

Send Pending LDAP Requests
Perform this task after successfully importing the self-service user roles.

Note:  This topic is only required only if SVC_CSS_USE_FA_AS_IDP profile option is set to TRUE.

With the import of the self-service roles to associate with the contact records, the final step to enable a self-service
user account is to create the user account in the Oracle Fusion Service identity management system. This is in turn
synchronized with Oracle Identity Cloud Service, allowing users to sign in. To create the user account in the Oracle
Fusion Service identity management system, the Send Pending LDAP Requests job needs to be run.

To send the pending LDAP requests:

1. Sign in to Oracle Fusion Service as an administrator or a setup user.
2. Navigate to the Scheduled Processes work area.
3. Click Schedule New Process.

The Schedule New Process dialog box appears.
4. Select the Job option.
5. Click the Name menu, then select Search.
6. Enter the following string in the Name text box, then click Search:

Send Pending LDAP Requests

7. Click Send Pending LDAP Requests, then click OK.
8. Click OK on theSchedule New Process dialog box.

The Process Details dialog box appears.
9. Click Submit.
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A Confirmation dialog is displayed.
10. Click OK.

Monitor the job. When it's complete, the newly imported self-service users are created in LDAP.

Removing Self-Service users through import
You can remove Self-Service users data using Self-Service Role import.

Removing Self-Service User data will not remove the following:

• Any contacts associated with the Self-Service user.

• The user account in the Identity Management System.

First you prepare the data file for the import process.

1. Get the role ID using the the selfServiceUsers REST API or selfServiceRoles REST API.

To use to selfServiceRoles REST API to get the Role ID of the user you can query by ContactPartyId and
RelationshipTypeCd set to ORA_CSS_USER.

2. When you start the import make sure the Import Mode is set to Delete Records as shown in the following
example:
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How do I use custom job roles in DCS?  
You can create a custom job role for Customer Self-Service users. It lets you create a custom object and assign privileges
to that object.

Note:  This step is optional for advanced setup of your application.

There are many reasons why you might create a custom job role for Customer Self-Service users. One possible reason is
when you create a custom object and want to assign privileges to that object.

Follow these steps to assign custom job roles for use in Digital Customer Service:

1. Create a custom role by making a copy of one of the following predefined roles:

◦ Customer Self-Service User

◦ Customer Self-Service Account Administrator

2. Set the value of the appropriate Digital Customer Service profile option to the name of the custom role you
created. The following profile options can be set to the name of the custom role:

◦ SVC_CSS_USER_ROLE_COMMON_NAME If the value of this profile option is set to the name of a custom role, then
all Customer Self-Service Users will be assigned this role when they're provisioned.

◦ SVC_CSS_ACCT_ADMIN_ROLE_COMMON_NAME If the value of this profile option is set to the name of a custom role,
then all self-service users who are assigned the Customer Self-Service Account Administrator role will
receive this custom role.

For more information about setting profile options, see How do I set profile options for Self-Service
Optimization?.

Note:  If you update these profile options to specify a custom role once your Digital Customer Service
application is in use, you must perform a mass update of any existing users from the old roles to the new
roles.

For each custom job role you create, you also must create a group in Identity Cloud Service. The external ID of the IDCS
group you create must match the code of the Fusion Service custom job role that you created. For more information
about creating IDCS groups, see How do I set profile options for Self-Service Optimization?.

How do I configure multiple business units with Digital
Customer Service?  
When you have multiple business units, additional configuration is required once you have created your Digital
Customer Service applications. Each business unit must have its own Digital Customer Service application.

Note:  Only one business unit is supported per Digital Customer Service application.
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Once you have created your Digital Customer Service applications, follow the instructions in the following sections of
this topic:

1. Locate the business unit ID in Oracle Fusion Service.
2. Specify the business unit ID in the Digital Customer Service application.
3. Configure the Business Unit ID for the Open Service Requests list.

Locate the Business Unit ID
To locate the business unit ID for your Digital Customer Service application:

1. Sign in to Oracle Fusion Service as an administrator or a setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Company Profile

◦ Task: Manage Business Unit

3. Locate your business unit in the Search Results list and copy the value in the BusinessUnitId column.
If you don't see a BusinessUnitId column, click the View menu to access the Columns menu, and then select
the columns to display.

Note:  You will need to use the value that you copied in "Specifying the Business Unit ID and Product Catalog
Usage Code in the Digital Customer Service Application" later in this answer.

Locate the Product Catalog Usage Code
To locate the Product Catalog Usage Code for your Digital Customer Service application:

1. Sign in to Oracle Fusion Service as an administrator or a setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Business Units

◦ Task: Manage Service Product Group Usage for Business Unit

3. Copy the value in the Business Unit Profile Value text box.
You will need to use the value that you copied in "Specifying the Business Unit ID and Product Catalog Usage
Code in the Digital Customer Service Application" later in this answer.

Note:  If you haven't yet set the scope for tasks, the Select Scope dialog box appears.

Specify the Business Unit ID and Product Catalog Usage Code in the Digital
Customer Service Application
Once you have located the business unit ID and product catalog usage code in Oracle Fusion Service, you must specify
them in your Digital Customer Service application.

To specify the business unit ID and product catalog usage code:

1. Sign in to Oracle Visual Builder.
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2. Open your Digital Customer Service application.
3. Click the Web Apps tile.
4. In the Web Apps tree, click dcs.

A dcs tab appears.
5. Click the (x) (Variables) icon.
6. Set the business unit ID:

a. Click businessUnitId.
b. In the Default Value text box, specify the value that you copied in Step 3 of the Locating the Business

Unit ID task.
7. (Optional) Set the non-default usage code:

a. Click usageCode.
b. In the Default Value text box, specify the value that you copied in Step 5 of the Locating the Product

Catalog Usage Code task.
8. Refresh your Digital Customer Service application.

Note:  When adding the Chat or Category Selector to a page, you must ensure that your businessUnitId property
is bound to $application.variables.businessUnitId. Moreover, when adding the Product Selector to a page, its
usageCode property must be bound to $application.variables.usageCode.

How do I add Visual Builder roles?  
You must add roles in Oracle Visual Builder and Oracle Visual Builder Studio to configure appropriate authorization for
your Oracle Visual Builder platform and editor.

Instead of assigning roles to each user individually, you can simplify the process by creating groups and adding users to
groups as a way to assign roles. Each time you add a user to a group, the user automatically gets the roles defined for
the group. Or you can assign individual users to the Visual Builder roles.

Add Users to a Group
Add users to a group so that they automatically get the permissions defined for the group.

1. Sign in to Oracle Identity Cloud Service Console as an administrator.
2. From the Oracle Identity Cloud Service console, click the Navigation menu icon.
3. Click the Groups tab.
4. On the Groups page, click the group that you want to assign users to or add a new group.
5. On the Group Details page, select the Users tab.
6. Click + Assign.
7. Select the users you want to add to the group, then click OK.

The selected users are added to the group. You can now assign roles to all the users in the group, if required.

Assign Users or Groups to Roles in Visual Builder
After you create groups and add users to groups, you can assign roles and provide access to services and instances to
all the members of the group at once.
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Assign Roles to Users in Visual Builder
1. In Identity Cloud Service, click the Navigation Drawer, and select Oracle Cloud Services.
2. Select your Visual Builder instance.

You can use the filter to help you find your instance. For Oracle Visual Builder Studio instances search for 
visualbuilder.

3. Click the Application Roles tab.
4. Click the menu options icon shown next to the role, and select Assign Users. To assign the role to a group, you

need to select Assign Groups.
5. Assign the Oracle Visual Builder Service Developer role to the group or users that require Build and Maintain

access in the Oracle Digital Customer Service applications.
6. Assign the Oracle Visual Builder Service Administrator role to the group or users that require Administrative

access to configure instance-wide settings for the Oracle Visual Builder environment for all applications.

Assign Roles to Users in Visual Builder Studio
Note:  The following VB Studio steps apply only to one pod, typically your TEST instance. VBCS, however, is
provisioned on all pods so those steps for the application roles are applicable to all instances.

1. Sign in to Identity Cloud Service, click the Navigation Drawer, and select Oracle Cloud Services.
2. From the Oracle Cloud console dashboard, navigate to the Identity Cloud console and click Applications.
3. Click the link for your Oracle Visual Builder Studio instance.

You can use the filter to help you find your instance. For Oracle Visual Builder Studio instances search for your
instance prefixed with "VBINST".

4. Click the Application Roles tab.
5. Click the menu options icon shown next to the role, and select Assign Users. To assign the role to a group, you

need to select Assign Groups.
6. Select the checkbox next to the name of each user that you want to add to the role, and then click Assign.

Note:  You must add the DEVELOPER_USER or the DEVELOPER_ADMINISTRATOR user roles.

How do I configure the Self-Service Registration object in
Digital Customer Service?  
Use this topic to configure the Self-Service Registration object.

Overview of the Self-Service Registration Object
Digital Customer Service self-service registration requests are submitted using the Self-Service Registration object.
This object is extensible and can be configured using the Application Composer in Oracle Fusion Service. With the
Application Composer, you can add new fields, validation rules and triggers to the object.

The payload of the REST request to the Self-Service registration resource can supply values for the following attributes:
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Basic attributes:

Attribute Name for the
SelfRegistration Object

Display Name Attribute in the Contact Object Type

EmailAddress
 

Email Address
 

EmailAddress
 

Text
 

AccountKey
 

Account Key
 

AccountKey
 

Text
 

FirstName
 

First Name
 

FirstName
 

Text
 

MiddleName
 

Middle Name
 

MiddleName
 

Text
 

LastName
 

Last Name
 

LastName
 

Text
 

PlaceOfBirth
 

Place Of Birth
 

PlaceOfBirth
 

Text
 

Address attributes:

Attribute Name for the
SelfRegistration Object

Display Name Attribute in the Contact Object Type

PrimaryAddressLine1
 

Primary Address Line 1
 

Address1
 

Text
 

PrimaryAddressLine2
 

Primary Address Line 2
 

Address2
 

Text
 

PrimaryCountry
 

Primary Country
 

Country
 

LOV
 

PrimaryCity
 

Primary City
 

City
 

LOV
 

PrimaryState
 

Primary State
 

State
 

LOV
 

PrimaryProvince
 

Primary Province
 

Province
 

Text
 

PrimaryPostalCode
 

Primary Postal Code
 

PostalCode
 

LOV
 

PrimaryAddressType
 

Primary Address Type
 

AddressType
 

Text
 

SecondaryAddressLine1
 

Secondary Address Line 1
 

Address1
 

Text
 

SecondaryAddressLine2
 

Secondary Address Line 2
 

Address2
 

Text
 

SecondaryCountry
 

Secondary Country
 

Country
 

LOV
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Attribute Name for the
SelfRegistration Object

Display Name Attribute in the Contact Object Type

SecondaryCity
 

Secondary City
 

City
 

LOV
 

SecondaryState
 

Secondary State
 

State
 

LOV
 

SecondaryProvince
 

Secondary Province
 

Province
 

Text
 

SecondaryPostalCode
 

Secondary Postal Code
 

PostalCode
 

LOV
 

SecondaryAddressType
 

Secondary Address Type
 

AddressType
 

Text
 

Contact Point attributes:

Attribute Name for the
SelfRegistration Object

Display Name Attribute in the Contact Object Type

RawWorkPhoneNumber
 

Raw Work Phone Number
 

RawPhoneNumber
 

Text
 

RawMobileNumber
 

Raw Mobile Number
 

RawPhoneNumber
 

Text
 

RawHomePhoneNumber
 

Raw Home Phone Number
 

RawPhoneNumber
 

Text
 

WorkPhoneCountryCode
 

Work Phone Country Code
 

PhoneCountryCode
 

Text
 

MobileCountryCode
 

Mobile Country Code
 

PhoneCountryCode
 

Text
 

HomePhoneCountryCode
 

Home Phone Country Code
 

PhoneCountryCode
 

Text
 

WorkPhoneAreaCode
 

Work Phone Area Code
 

PhoneAreaCode
 

Text
 

MobileAreaCode
 

Mobile Area Code
 

PhoneAreaCode
 

Text
 

HomePhoneAreaCode
 

Home Phone Area Code
 

PhoneAreaCode
 

Text
 

WorkPhoneExtension
 

Work Phone Extension
 

PhoneExtension
 

Text
 

MobileExtension
 

Mobile Extension
 

PhoneExtension
 

Text
 

HomePhoneExtension
 

Home Phone Extension
 

PhoneExtension
 

Text
 

WorkPhoneNumber
 

Work Phone Number
 

PhoneNumber
 

Text
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Attribute Name for the
SelfRegistration Object

Display Name Attribute in the Contact Object Type

MobileNumber
 

Mobile Number
 

PhoneNumber
 

Text
 

HomePhoneNumber
 

Home Phone Number
 

PhoneNumber
 

Text
 

During the approval process, a contact record is created, and the attributes of the Self-Service Registration object
can be transferred to the Contact object. The value assigned to the SVC_CSS_REG_CONT_MAP profile option determines
which attributes in the Self-Service Registration object are transferred to which attributes in the Contact object.
The default is an empty string. You specify a value for this profile option only if the name of the attribute in the Self
Registration object is different from the name in the Contact object. Cases where they may happen are if you have
created a custom attribute for an object. Custom attributes are designated with an _c, such as PlaceOfBirth_c. For this
use case, you ignore the _c when determining whether an attribute maps or not. So, let's take the custom attribute in
the Self Registration object PlaceOfBirth_c. Since the Contact object has a out of the box attribute called PlaceOfBirth
no mapping is required since the two values match. If, however, the name of the custom attribute was BirthPlace_c the
value of this profile option would then be BirthPlace_c:PlaceOfBirth.

Usage Example
For business reasons, if additional information needs to be gathered about the user submitting a registration request,
custom fields can be added to the Self-Service Registration Object. If an additional field is a required, then a value must
be provided in the REST request sent to the Self-Service Registration object.

If a new required custom attribute is added to the Contact object, a new custom attribute must also be added to the
Self-Service Registration object and then specified in the SVC_CSS_REG_CONT_MAP profile option. This will transfer the value
of the new attribute of the Self-Service Registration object to the new attribute of the Contact object.

For example, let's say there's a custom attribute in the Self Registration object called PlaceOfBirth_c. This attribute can
be added to the Self-Service Registration object and mapped to the Place of Birth attribute that already exists on the
Contact object. If the name of the attribute is BirthPlace_c then the value of SVC_CSS_REG_CONT_MAP profile option should
be BirthPlace_c:PlaceofBirth. You can map multiple attributes using colon separating fields, and commas separating
the pairs. For more information, see the entry in the Registration Profile Options table in How do I configure DCS profile
options?.

Note:  The API Name of the new attribute is different from the Name.

Here are the tasks that you need to complete to address this use case:

1. Create the Field
2. Test the REST Request
3. Modify the Profile Option

Create the Field
First, you need to create the field.

To create the field:

1. Sign in to Oracle Fusion Service as an administrator or a setup user.
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2. Create a sandbox for adding the Place of Birth field:

a. Click Navigator > Configuration > Sandboxes.
b. Click Create Sandbox.

The Create Sandbox page appears.
c. Enter a name in the Name field.
d. From the All Tools list, select Application Composer.
e. Click Create.
f. In the Available Sandboxes list, click the name of the sandbox name that you specified in step c.

g. Click Enter Sandbox.
3. Navigate to Application Composer.
4. Expand Objects, then Standard Objects, then Self-Service Registration, and then click Fields.

The Fields page appears.
5. Click Create a custom field.
6. Click the Text option, then click OK.
7. Specify the following for the Date field options:

◦ In the Display Label field, enter the following string:

Birth Place

◦ The Name field will be pre-populated based on the name that you entered for the Display Label, without
any spaces.

◦ The API Name field will be pre-populated based on the name that you entered for the Display Label,
without any spaces, and typically with the following suffix: _c

Tip:  Note the value assigned to the Birth Place field, because it will be assigned to the
SVC_CSS_REG_CONT_MAP profile option in the Modify the Profile Option task, later in this topic.

◦ Deselect the Required option in the Constraints section.

◦ Select the Updatable option in the Constraints section.

◦ Deselect the Searchable option in the Constraints section.

◦ Select the Include in Service Payload option in the Constraints section.

8. Click Save and Close.

Test the REST Request
Use the following sample curl command to test the REST request. You must set the profile option before you complete
your testing. Also, given a meaningful value for the Birth Place (Birthplace_c) field such as "2001-01-01".

Note:  This is only an example. Your curl command must include details relevant to your deployment.

curl -X POST \
 https://myhost.us.example.com/crmRestApi/resources/11.13.18.05/selfRegistrations \
 -H 'Accept: application/json' \
 -u "<user_name>:<password>" \
 -H 'Content-Type: application/vnd.oracle.adf.resourceitem+json' \
 -d '{
 "AccountKey": "HDFC Bank",
 "PersonFirstName": "Lilly",
 "PersonLastName": "Inigo",
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 "EmailAddress": "lilly.inigo@example.com" ,
 "BirthPlace_c":"New York"

Modify the Profile Option
To modify the SVC_CSS_REG_CONT_MAP profile option so that it includes the Place of Birth field:

1. Sign in to Oracle Fusion Service as administrator or a setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Digital Customer Service

◦ Task: Manage Digital Customer Service Profile Options

3. Click the SVC_CSS_REG_CONT_MAP profile option.
4. Add the following profile option value to the list of values:

BirthPlace_c:PlaceOfBirth

5. Click Save and Close.

Usage Example with Multiple Mappings
Now, let's briefly consider a scenario with multiple mappings.

First, you specify the case sensitive name and value pairs to map the fields of the Registration View object to the
Contact View object. Here's how you do it: in the following way:

• reg_field1:contact_field1,reg_field2:contact_field2

Where, the reg_field1 is the PlaceOfBirth_c in the Registration View Object which is itself a custom object created in
Application Composer.

The contact_field is the PlaceOfBirth field in the Contact View object. This attribute is already present in the Contact
object.

So the mapping would be: reg_field1:contact_field1 LIKE BirthPlace_c:PlaceOfBirth

How do I set up vanity URLs?  
The Vanity URL feature enables you to map a custom domain to your Oracle Visual Builder instance and Digital
Customer Service Application.

This topic describes how to provide a replacement domain to use instead of the typical Oracle domain. The Vanity URL
feature is distinct from domain forwarding, where the browser gets redirected. With the CNAME mapping described
here, your users will never see the Oracle domain in their browser.

To successfully set up a vanity URL, follow the following three tasks in this topic:

1. Configure a Domain Provider
2. Log a Service Request for Oracle Support
3. Set Up the Root URL App

24



Oracle Fusion Cloud Applications
Digital Customer Service Questions and Answers

Chapter 1
Questions and Answers

Prerequisites
Before following the steps in this task you must make sure you own the sub-domain that you want to use and have
access to the SSL certificate bundle information.

Note:  If you have multiple Digital Customer Service applications you must perform these configuration steps on each
one.

Configure the Domain Provider
The following instructions represent a generic overview for configuring a domain provider. The exact steps might be
different, depending on your domain provider.

1. Create or identify a subdomain to map to Oracle Visual Builder via a domain provider. For example: https://
myvanity.example.org.

2. Add a CNAME record for the subdomain to map to the Oracle Visual Builder instance URL. For example, create
a CNAME record for https://myvanity.example.org that points to myvbinstance.builder.ocp.oraclecloud.com.

3. Ensure a valid SSL certificate applies to that subdomain, either through your domain provider or through a valid
certifying authority. For example, Comodo, DigiCert, or other.

Note:  Even though it's possible to use a wildcard SSL certificate (*.example.org), the certificate bundle needs
to be maintained on the server. Because of this, you will want to consider an SSL certificate, specifically for
that subdomain. The following example shows a wildcard certificate issued for the *.example.org domain.

4. Ensure that you have extracted or exported the bundle that contains the certificate and private key, because the
certificate bundle will be managed on the server.

Note:  Depending on your domain provider, you may need to indicate that you want to use the certificate on
your own server in order to download the bundle.

You should now have a certificate along with a private key file.

Log a Service Request for Oracle Support
Now, you need to log a Service Request (SR) with Oracle Support to request your Oracle Visual Builder instance to be
configured with your vanity domain.

1. Navigate to the Oracle Support site.
2. Sign in using your user name and password.
3. Create an SR. Your SR must include the following information:

◦ The full VB URL Designer URL. For example: myvbinstance.builder.ocp.oraclecloud.com.

◦ This the CNAME as provided and the VB domain e.g. myvbinstance.builder.ocp.oraclecloud.com.

◦ The Certificate and Private key files. For example, the keys ending in .cer and .key.

Set Up the Root URL App
Follow the steps in this task to configure the custom URL for your domain.
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To map a custom domain to your application:

1. In Visual Builder, click the Web Applications tab, and then click Menu and select Settings, as shown in the
following example:

2. In the Settings dialog box, enter the URL into the Vanity URL text field and click Close.
The URL must be the full URL that you want to use and it must use valid form (for example, https://
myvanity.example.org).

After you publish your DCS application, a visitor can type the custom domain (for example, https://foo.example.org)
in the browser to open the web application. The URL won't contain any additional path parameters because the app is
loaded as the root domain.

How do I activate Digital Customer Service as an existing
user?  
To perform this step you must have the Service Administrator role. The Service Administrator receives the "Action
Required" welcome email from Oracle. As the designated activator of the Oracle Digital Customer Service service, the
activator is only required to kick off the provisioning process.

1. Open the email prefaced "Action Required" that you received from Oracle Cloud.
2. Review the information about your service in the email, and then click the provided link to activate your

service..
3. Enter your cloud account name, and click Next.
4. Click Continue on the Cloud Tenant page.
5. On the log in page, enter your cloud account credentials, and click Sign In.

The My Services page appears.
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6. Click the Manage Account tile.
7. On the Account page, click the Activate tab.
8. Choose the service you want to activate, and click the Cloud Services Account Setup button.
9. Click the Cloud Account Name drop down list and select the cloud account you want to activate the service

into and then click the Assign Account button.

You receive a Review Summary message when the order is successfully activated.
10. Click Close to complete the activation phase.

The account is now ready to use.

How do I set profile options for Self-Service
Optimization?  
Self-Service Optimization gives you greater flexibility by using proxy users in Fusion Service

You must set the required profile options for Self-Service Optimization. There are also optional profile options for other
functionality.
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Set Required Digital Customer Service Profile Options
The profile options specific to Digital Customer Service are found in two task areas: Manage Digital Customer Service
Profile Options and Manage Digital Customer Service Account Setup Profile Options.

1. Sign in to Oracle Fusion Service as administrator or a setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Digital Customer Service

◦ Task: Manage Digital Customer Service Profile Options

or

◦ Task: Manage Digital Customer Service Account Setup Profile Options

3. Click the name of the profile option that you want to change.
4. Set the profile option value as needed.
5. Click Save and Close.
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Required Profile Options and Descriptions Default Value Comments

FND_IDP_PROXY_USER_WHITELIST
 
Used to identify the list of allowed proxy users.
 

None
 

Enter a comma-separated list of proxy user
names.
 

Note:  There must be no spaces between the
commas and the names.

ORA_CORS_ORIGINS
List of trusted domains that can make requests.
 

None *, or specific comma-separated fully qualified
domain names.

CORS_ACCESS_CONTROL_ALLOW_HEADERS
 
Specifies comma-separated list of headers that
are allowed as part of a CORS request.
 

 Add these values, in the comma separated list,
 if they're not present:
 
Puds-Access-Token, kmauthtoken, content-
language, X-Oracle-ABCS-SessionId, X-Oracle-
ABCS-UserId
 

SVC_CSS_PUDS_CACHE_DURATION
 
Decides the amount of time, in minutes, that
Proxy User Data Service objects are cached.
 

15 minutes
 

Any changes to this parameter will force a
refresh of the proxy users configuration data
cache.
 

SVC_CSS_USE_FA_AS_IDP
 
Identifies if self-service users are created in
Fusion Service or in IDCS.
 

False.
 

Make sure this value is set to False for self-
service optimization mode.
 

Set Optional Profile Options
Profile options enable you to configure and control application data centrally. They store user preferences, installation
information, configuration choices, and processing options. Administrators and setup users manage profile options in
the Setup and Maintenance work area.

Registration Profile Options

Profile Option Default Value Possible Values Effect

SVC_CSS_SELF_REGISTRATION
 

New Or Existing
 

None
 
New Or Existing
 
Existing Only
 

Specifies which contacts can self-
register. If Existing is specified,
only existing contacts can self-
register.
 

SVC_CSS_SELF_REG_AUTO_
APPROVE
 

False
 

True
 
False
 

Enables automatic approval of self-
service registration requests that
are associated with an account.
 
If SVC_ CSS_ SELF_ REG_AUTO_
APPROVE is set to False and SVC_
 CSS_ ACCT_ADMIN_APPROVE
is set to True, then the Digital
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Profile Option Default Value Possible Values Effect

Customer Service Account
Administrators can approve user
registration requests in the Digital
Customer Service Customer user
interface. Also, Digital Customer
Service Administrators can approve
registration requests in the Digital
Customer Service Administration
user interface.
 

SVC_CSS_ACCT_ADMIN_APPROVE
 

True
 

True
 
False
 

Enables the approval of self-service
user registration requests by users
with Digital Customer Service
Account Administrator roles.
 
If set to True, Digital Customer
Service Account Administrators
can approve user registration
requests in the Digital Customer
Service customer user interface
and Digital Customer Service
Administrators can approve
registration requests in the Digital
Customer Service Administration
user interface.
 
If set to False, only Digital
Customer Service Administrators
can approve registration requests
in the Digital Customer Service
Administration user interface.
 

Note:
This option applies only when
the SVC_ CSS_ SELF_ REG_
AUTO_APPROVE option is set to
False.
 

SVC_CSS_ACCT_KEY_FIELD
 

OrganizationName
 

Any field in the Account object
 

Specifies a valid field name in the
Account object. The field name is
case sensitive.
 

Note:
You must create an attribute
in the account object to be the
account key, because the default
account key of account name
isn't secure.
 

SVC_CSS_REG_CONT_MAP
 

An empty string
 

An empty string.
 
Any defined value, with a colon
separating fields, and commas
separating the pairs.
 

You specify a value for this profile
option only if the name of the
attribute in the Self Registration
object is different from the name
in the Contact object. Cases where
they might happen are if you've
created a custom attribute for
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Profile Option Default Value Possible Values Effect

For example, reg_field1:contact_
field1, reg_field2:contact_field2
 

an object. Custom attributes are
designated with an _c, such as
PlaceOfBirth_c. For this use case,
 you ignore the _c when decide
whether an attribute maps or not.
 
So, let's take the custom attribute
in the Self Registration object
PlaceOfBirth_c. Because the
Contact object has a ready to use
attribute called PlaceOfBirthno
mapping is required because the
two values match. If, however,
 the name of the custom attribute
was BirthPlace_c the value of
this profile option would then be
BirthPlace_c:PlaceOfBirth.
 
Here's an extra example with
multiple mappings:
 
First, you specify case sensitive
name and value pairs to map
the fields of the Registration
View object to the Contact View
object in the following way: reg_
field1:contact_field1,reg_
field2:contact_field2.
 
The reg_field1 is the
PlaceOfBirth_c in the Registration
View Object which is a custom
object created in Application
Composer.
 
The contact_field is the
PlaceOfBirth field in the Contact
View object. This attribute is
already present in the Contact
object.
 
So the mapping would be:
 
reg_field1:contact_
field1 LIKE BirthPlace_
c:PlaceOfBirth
 

SVC_CSS_SIGN_IN_ATTR_NAME
 

EmailAddress
 

The value of the assigned attribute
must be unique.
 
Possible values include:
 
EmailAddress
 
 

Specifies the sign-in attribute
that users must specify in the
Sign in ID field in the Self-Service
Registration object. This field is
used to decide whether the user
exists in the Lightweight Directory
Access Protocol server.
 

SVC_CSS_REG_FLD_CONTACT
 

EmailAddress
 

Any field on the Self-Service
Registration object.
 

Specifies the field to use during the
user registration process to decide
if the registering user is an existing
contact. The field names are case
sensitive.
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Profile Option Default Value Possible Values Effect

The SVC_CSS_REG_CONT_MAP
profile option is used to find the
name of the attribute on the
Contact.
 

SVC_CSS_SEND_WELCOME_EMAIL
 

True
 

True
 
False
 

Enables sending a welcome
email when a new user account is
created.
 

SVC_CSS_USER_ROLE_COMMON_
NAME
 

ORA_SVC_CUSTOMER_SELF_
SERVICE_ USER_ABSTRACT
 

A string representing the name of
the role that's set up for Customer
Self-Service users. Typically, this is
a copy of a Customer Self-Service
User with extra privileges added.
 
 

Specifies the common name of the
role granted to previously created
Customer Self-Service Users.
 

SVC_CSS_ACCT_ADMIN_ROLE_
COMMON_NAME
 

ORA_SVC_CUSTOMER_
SELF_SERVICE_ ACCOUNT_
ADMINISTRATOR_ABSTRACT
 

A string representing the name
of the role that's set up for
Customer Self-Service Account
Administrator. Typically, this is a
copy of a Customer Self-Service
Account Administrator with extra
privileges added.
 
 

Specifies the common name of
the role granted to the previously
created Customer Self-Service
Account Administrators.
 

SVC_CSS_USER_CATEGORY
 

An empty string
 

A string
 

Specifies the user category that
defines the URL to which the self-
service user is redirected after a
password reset.
 
The user category is defined in the
Security Console.
 

SVC_CSS_IMP_SIGN_IN_ATTR_
NAME
 

PrimaryEmailAddress
 

Any field on the Contact object.
 

Specifies a field in the Contact
object to be used as the sign-in
attribute when importing data into
the Self-Service Roles object. The
field name is case sensitive.
 

SVC_CSS_USE_FA_AS_IDP
 

False
 

True
 
False
 

Specifies whether the identity
provider is Oracle Fusion
Applications or Oracle Identity
Cloud Service.
 
When set to True, Oracle Fusion
Applications is used.
 

ORA_SVC_CSS_SELF_REG_B2C_
AUTO_APPROVE
 

True
 

True
 
False
 

Enables automatic approval of self-
service registration requests that
aren't associated with an account.
 
If set to True, users who register
without an account will be auto
approved to become self-service
users. If set to False, users who
register without an account
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Profile Option Default Value Possible Values Effect

will need to be approved by an
administrator before they can
become self-service users.
 

SVC_CSS_PUDS_CACHE_
DURATION
 

15
 

Integer in minutes
 

Decide the amount of time,
in minutes, that Self-Service
Optimization objects are cached.
 

SVC_CSS_ALLOW_CONTACT
 

True
 

True
 
False
 

Enables the self-service
registration of B2C Service
contacts.
 

SVC_CSS_ALLOW_CONSUMER
 

True
 

True
 
False
 

Enables the self-service
registration of consumers.
 

SVC_CSS_CONSUMER_USER_
CATEGORY
 

An empty string
 

A string
 

Specify the user category for
consumers defining the redirect
URL for self-service users after a
password reset.
 

Knowledge Setup Profile Options

Profile Option Default Value Possible Values Effect

CSO_CONTENT_RATING_TYPE
 

None
 

True and False
 

Enables content rating for
Knowledge.
 

How do I set proxy user credentials in DCS?  
Complete the configuration of the proxy user configuration data for the Self-Service Optimization feature, you need to
set the user credentials for the proxy users.

1. Sign in to Fusion Service as an administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service.

◦ Functional Area: Digital Customer Service.

◦ Task: Manage Proxy User Configuration Data.
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3. Find any line referencing the following proxy user keys:
◦ PUK#_ANONYMOUS_USER

◦ PUK#_SELF_SERVICE_USER

◦ PUK#_SELF_SERVICE_ACCOUNT_ADMIN
4. Do the following with each of the three user keys:

a. Select the entry, then from the Actions menu, click Edit.
b. In the Edit Proxy User Configuration Data workspace, enter the Proxy User Name if it's different from the

default name.
Note:  It's recommended that you retain the proxy user names.

c. Enter the password for the proxy user.
d. Click Save and Close.

Because the same proxy user key is used by multiple URLs, you can edit any one URL that uses this proxy user key to set
the proxy user credentials associated with that key.

Note:  Proxy user configuration data is cached for a duration specified by the SVC_CSS_PUDS_CACHE_DURATION
profile option.

How do I configure the Resend Welcome and Password
Recovery email templates?  
As part of user registrations, a user is created in IDCS and initially the user record is inactive.

After all the data related to the user is stored in the appropriate locations, the user is activated again and an API call is
made to resend the Welcome email. To prevent a user from receiving multiple emails and to ensure the user sees the
appropriate welcome message you've two configuration tasks depending on the scenario.

• You use the Resend Welcome template when a new user has signed up.

• You use the Password Recovery template when the user has been migrated.

Here are both tasks:

Configure the Resend Welcome Template
1. Sign in to Identity Cloud Service as a user with Administrative access
2. From the Navigation drawer, select Settings, and then Notifications.
3. Click the Configure tab.
4. Deselect the Welcome and User Activation check boxes.
5. Make sure the Resend Welcome checkbox is selected.
6. Click Save, then when the confirmation dialog box appears click OK.
7. Click the Email Templates tab.
8. Expand the Resend Welcome template, and replace the existing Subject line and message text with you own

information and click Save.
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Configure the Password Recovery Template
1. Sign in to Identity Cloud Service as a user with Administrative access
2. From the Navigation drawer, select Settings, and then Notifications.
3. Click the Configure tab.
4. Deselect the Welcome and User Activation check boxes.
5. Make sure the Password Recovery Request checkbox is selected.
6. Click Save, then when the confirmation dialog box appears click OK.
7. Click the Email Templates tab.
8. Expand the Password Recovery Request template, and replace the existing Subject line and message text with

you own information and click Save.

How do I set up Self-Service Registration without an
account key requirement?  
Administrators can enable this feature in the Setup and Maintenance work area. This feature is delivered enabled.

Note:  After enabling the self-service registration without an account key requirement, as specified in this section, the
ODCS application developer specifies whether or not to require the account key by specifying the ODCS application-
level variable userRegistrationType. The value consumer is used if you don't want to specify an account key. The
default is contact, which requires an account key.

1. Sign in to Fusion Service as an administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service.

◦ Functional Area: Digital Customer Service.

◦ Task: Manage Digital Customer Service Profile Options.

3. Locate the SVC_CSS_ALLOW_CONSUMER profile option and set it to Yes.
4. Optional step: Locate the SVC_CSS_CONSUMER_USER_CATEGORY and set it to the user category for

consumers which defines the redirect URL for self-service users after a password reset.

After these settings are enabled, the Account key field will no longer be required for self-service users to
register in the ODCS application.

How do I enable my own sign in pages?  
To enable your own sign-in pages, you must first update your Digital Customer Service application configuration to use
Digital Customer Service as the Security provider.

After doing this, VBCS will inject data into the app-flow.json file which will allow the Digital Customer Service

Security Provider to have access to the same IDCS configuration information as the standard VB security provider. In
addition to enabling you to create your own sign-in page, using the Digital Customer Service Security Provider enables
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you to use the Change Password button on the My Profile page in the out of the box reference implementation. That
button takes the user to the reference implementation's Change Password page.

1. Using the application navigator's Source View, navigate to webApps > webAppName > app-flow.json.
2. Locate the userConfig element in the app-flow.json file of the application in the DT editor, and replace

the child element "type": "vb/DefaultSecurityProvider" with : "type: "oj-odcs/application-common/
OdcsSecurityProvider".

3. Then, add "defaultSecurity": true.

This entry must be a child element of the "userConfig/configuration" element which tells VBCS to send IDCS
configuration data to the app-flow.json file during application staging. Here's how the updated "userConfig"
element should look:

"userConfig": {
 "type": "oj-odcs/application-common/OdcsSecurityProvider",
 "configuration": {
 "defaultSecurity": true,
 "authentication": {
 "type": "implicit"
 }
 },
 "embedding": "deny"
 }

You can optionally specify the custom sign-in page for Digital Customer Service by setting
userConfig.configuration.odcsLoginPath to point to a VB page path. If this path isn't specified, the RI default of shell/
sign-in is used.

Set the Service Instance URL
Now you must set the service instance URL for the idcsRestApi Service Connection.

1. In Oracle Visual Builder, open your Digital Customer Service application (if it's not open already).
2. Click Service Connections, click idcsRestApi, and then click the Servers tab.
3. Click Edit, then in the Edit Server page, edit the Instance URL to be the URL of your IDCS server. For example:

https://idcs-xxx.identity.yyy.idcs-example.com.
4. Click Save.

Verify the Identity Cloud Service Identity Provider Policy
If you have a custom sign-in page for your Digital Customer Service application confirm that IDCS is enabled to use the
User Name-Password authentication factor.

1. In the Identify Cloud Service administration console, click the Navigation Drawer, the expand Security, and
choose IDP Policies.

2. Click Default Identity Provider Policy, and then the Identity Provider Rules tab.
3. Click the Menu icon and choose Edit.
4. In the Edit Default IDP Rule dialog box, make sure Username-Password is shown in the Allowed Identity

Providers box. If not, do the following:

a. Click in the Assign Identity Providers box, and select Username-Password.
b. Click Save.

If you don't want to add Username-Password to the Default Identity Provider Policy, you can add a new IDP Policy for the
Digital Customer Service application to use. When you create the new policy, add a rule that allows the Username-
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Password Identity Provider and assign the VBINST_xxxxx application to the policy. This will ensure that the application
uses the new IDP policy instead of the default IDP policy.

For more information, see Related Topics for a link to the Identity Cloud Service documentation.

Related Topics
• Understand Identity Provider Policies

What are the Digital Customer Service Developer roles?  
To work with business objects relevant to Digital Customer Service, the developer must be a Digital Customer Service
user and must be granted the appropriate roles. Here are thee tasks you'll need to perform:

1. Create an Internal Customer Account (This task only needs to be done once). How do I create an Internal
Customer account?

2. Register the Developer as a Self-Service User. How do I create an Internal Customer account?
3. Add User Roles. How do I add Visual Builder roles?

How do I create a custom report based on a data model? 

Now you can create a report based on the data model you have created.

1. Log in to Fusion Service as a user who can use Reports and Analytics.
2. Click Navigator > Tools > Reports and Analytics.
3. On the Reports and Analytics page, click Create, and then select Report.
4. Select Use Data Model, then click the search icon and locate the data model you previously created.
5. Click Next.
6. On the Select Layout page, choose the Landscape page option, and the Table layout option, and then click

Next.
7. On the Create Table page, deselect Show Grand Totals Row and then click Next.
8. On the Save Report page, click Customize Report Layout.
9. Click Finish.

10. In the Save As dialog box, enter a name such as Migration Report, and then click OK.
11. Add a layout grid by doing the following:.

a. In the report editor, click Drop a Data Item Here, and press the delete button on your keyboard.
b. Click the Insert tab (if it's not already selected).
c. Drag the Layout Grid from the Components list and drop it below the report title.
d. In the Insert a Layout Grid dialog box, enter 1 in the Rows box, and leave the Columns box as 2, and then

click OK.
e. Click the Insert tab again, and from the Components list, drag a Text Item and drop it in the first column.
f. Double-click the text item and enter the following: Job started on or after.

g. From the Data Source pane, drag the JOB_START_DATE parameter to the second column.
h. Reduce the width of the Job started on or after column.
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12. Add a repeating section component by doing the following:
a. Click the Insert tab, and then drag the Repeating Section component and drop it below the Layout Grid.
b. In the Insert a Repeating Section dialog box, select JOB ID from the Element drop down list, and then

click OK.
c. Click the Insert tab, and drag a Layout Grid and drop it into the repeating section.
d. Click the Insert tab, and drag a Text Item and drop it in the first column.
e. Double-click the text item and enter the following: Job ID.
f. From the Data Source pane, drag the JOB_ID parameter to the second column.

g. Re-size the first column.
13. Now add a data table by doing the following:

a. Click the Insert tab, and drag the Data Table component and drop it under the row in the repeating
component,

b. While the data table is selected, click the Show drop down list on the Table tab and select the first item
that indicates no (darkened) summary row.

c. From the Data Source pane, drag and drop the following fields into the data table:
- Event ID
- Contact Party ID
- Login ID
- Event Type
- Event Status
- Comments

14. Click the Save icon, and then click the Done button to access the report in View mode.
15. In the Start Date field, enter a job start date, and then click Apply to view the report.

How do I create an Internal Customer account?  
Before creating the Digital Customer Service developer or administrator users, an internal customer account must be
created for these users.

The internal customer account lets you associate your staff to a specific account. An account key is required when
creating a new Digital Customer Service user.

Note:  You only need to create the internal customer account once. This internal customer account can be used by all
Developers and Administrators.

To create an internal customer account:

1. Sign in to Oracle Fusion Service.
2. Navigate to the Service work area and click Accounts.
3. Click Create Account.
4. Enter the Name.

Note:  The name that you enter in this field represents the AccountKey that you need to use in the
Create Digital Customer Service Developers topic. This is true only if the value of the profile option
SVC_CSS_ACCT_KEY_FIELD hasn't been changed.
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5. Select Customer from the Type menu.
6. Click Save and Close.

How do I enable my own Forgotten Password page?  
This topic is required to set up Identity Cloud Service to include the Digital Customer Service Reset Password page URL
link when a user requests a password reset.

For this functionality to work Identity Cloud Service requires a REST request to be made to the IDCS /Settings API
by a tenant administrator to set allowedNotificationRedirectUrls to include the Digital Customer Service Reset
Password page URL. This setting defines the allowed notification redirect URLs which can be specified as the value of
notificationRedirectUrl in the POST .../admin/v1/MePasswordResetRequestor request payload, which is then included in
the reset password email notification sent to a user as part of the forgot password and password reset flow.

If you need to create the App in IDCS, see Create a Client application.

Note:  You must have Identity Administrator role and the Client ID and Client Secret must be for an IDCS application
which has either the Identity Domain Administrator or Security Administrator application role granted. This is required
to successfully call the /Settings REST API.

Use the following PowerShell script. If you're using a Mac or Linux computer, you'll need to install PowerShell first to run
the script. See Microsoft's website for details. PowerShell is installed by default on Windows.

Save the following script in a file called passwordreset.ps1 and change the '...' values in the script as appropriate for
your environment.

• To run the script from a Command Prompt on Windows enter: powershell -File passwordreset.ps1

• To run the script on Mac or Linux enter: pwsh passwordreset.ps1

### MODIFY THE FOLLOWING VARIABLES FOR YOUR IDCS/ODCS ENVIRONMENT ###
 
# Set IDCS variables (modify for your IDCS instance)
$IdcsUrl = '...' # e.g. 'https://idcs-xxx.identity.yyy.idcs-example.com'
$ClientId = '...' # Client ID for privileged app in IDCS
$ClientSecret = '...' # Client Secret for privileged app in IDCS
 
# Either set the first 3 variables below for your ODCS app or explictly define $ForgotPasswordUrl
$OdcsHost = '...' # e.g. 'my-odcs-example.com'
$OdcsAppName = '...' # e.g. 'my_odcs_app'
$OdcsVersion = '...' # e.g. '1.1'
$ForgotPasswordUrl = "https://${OdcsHost}/ic/builder/rt/${OdcsAppName}/${OdcsVersion}/webApps/dcs/?
page=shell&shell=forgot-password"
 
### DO NOT MODIFY THIS SCRIPT BELOW THIS LINE ###
 
# Generate an access token
$Credentials = [Convert]::ToBase64String([System.Text.Encoding]::UTF8.GetBytes("${ClientId}:
${ClientSecret}"))
$Uri = "$IdcsUrl/oauth2/v1/token"
$Headers = @{
 Authorization = "Basic $Credentials"
}
$Parameters = @{
 grant_type = 'client_credentials'
 scope = 'urn:opc:idm:__myscopes__'
}
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try {
 $Response = Invoke-RestMethod -Uri $Uri -Method POST -Headers $Headers -Body $Parameters
} catch {
 Write-Host ("Access token request POST to {0} failed with an error: {2}`nForm parameters: {1}`nException:
 {3}" -f $Uri, ($Parameters | Out-String), $_.ErrorDetails, $_.Exception) -fore red
 exit
}
$AccessToken = $Response.access_token
 
Write-Debug "Access Token = $AccessToken"
 
# Check the 'allowedNotificationRedirectUrls' IDCS Setting value
$Uri = "$IdcsUrl/admin/v1/Settings/Settings/?attributes=allowedNotificationRedirectUrls"
$Headers = @{
 Authorization = "Bearer $AccessToken"
 'Content-Type' = 'application/scim+json'
}
try {
 $Response = Invoke-RestMethod -Uri $Uri -Method GET -Headers $Headers
} catch {
 Write-Host ("Request to GET {0} failed with an error: {1}. `nException: {2}" -f $Uri, $_.ErrorDetails,
 $_.Exception) -fore red
 exit
}
$AllowedUrls = $Response.allowedNotificationRedirectUrls
 
Write-Debug "Allowed URLs from GET /admin/v1/Settings/Settings = $AllowedUrls"
 
# Add the forgot password URL to the Settings, if required (i.e. not already in $AllowedUrls)
if ($null -ne $AllowedUrls -And $AllowedUrls.Contains($ForgotPasswordUrl)) {
 Write-Output "URL ($ForgotPasswordUrl) is already registered"
} else {
 # Remove query parameter from /Settings URL, headers remain as for previous request
 $Uri = "$IdcsUrl/admin/v1/Settings/Settings/"
 
 # Add new URL and format the list for inclusion in the JSON payload (without powershell encoding)
 $AllowedUrls += $ForgotPasswordUrl;
 $AllowedUrls = '"{0}"' -f ($AllowedUrls -join '","')
 $Body = '{
 "schemas": [
 "urn:ietf:params:scim:api:messages:2.0:PatchOp"
 ],
 "Operations": [
 {
 "op": "replace",
 "path": "allowedNotificationRedirectUrls",
 "value": [' + $AllowedUrls + ']
 }
 ]
 }'
 
 try {
 $Response = Invoke-RestMethod -Uri $Uri -Method PATCH -Headers $Headers -Body $Body
 } catch {
 Write-Host ("Request to PUT {0} to {1} failed with an error: {2}. `nException:{3}" -f $Body, $Uri,
 $_.ErrorDetails, $_.Exception) -fore red
 exit
 }
 
 $AllowedUrls = $Response.allowedNotificationRedirectUrls
 Write-Output "Added new URL: $ForgotPasswordUrl"
}
 
Write-Output "`nAllowed Notification Redirect URLs:"
Write-Output $AllowedUrls
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What are the work order components?  
This topic lists and describes work order components.

The following table describes components specific to Work Orders. It also lists the restrictions associated with the
component and any additional configuration required.

Note:  To use work orders in your Digital Customer Service application, you must first complete the setup of either
general work orders or Oracle Field Service work orders with Fusion Service. For more information, refer to the
following guides:

• Integrating Fusion Service with Field Service

• Implementing Fusion Service

Component Name Description

Work Order List
 

Displays a list of work orders to the account user in a preconfigured Oracle Visual Builder list view. The
presentation of a row can be edited. Provides the capability to search for a work order and sort the list
of work orders.
 

Work Order Data
 

Displays the summary details of a work order. Provides the capability to update contact information,
 add a message for the technician, reschedule a work order and cancel a work order. It also provides
information about the technician and displays the technician's location.
 

Note:
Self-Service users can only reschedule Oracle Field Service work orders, not generic work orders.
 

How do I set up Digital Customer Service self-service
registration?  
There are two types of Self-Service registration requests, Fusion and B2C.

• You allow Fusion requests by setting the value of the SVC_CSS_ALLOW_CONTACT profile option to TRUE.

• You allow B2C requests by setting the SVC_CSS_ALLOW_CONSUMER profile option to TRUE.

The following users can submit self-service registration requests::

• Anonymous Users

• User with Customer Self-Service Administration duty role

• User authenticated by IDCS through the Proxy User Data Service
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Here's how the self-service registration request works:

First, the registration request is validated. If no errors are found, the status of the request is set to ORA_CSS_PENDING.
If the value of profile option (either SVC_CSS_ALLOW_CONTACT for Fusion, or SVC_CSS_ALLOW_CONSUMER for B2C)
is set to TRUE then the process continues.

If the profile option is set to FALSE, then the request must be manually initiated by a user with either the
Customer Self-Service Account Administrator job role or Customer Self-Service Account Administration
duty role. The name of the profile option is SVC_CSS_SELF_REG_AUTO_APPROVE for Fusion requests and
ORA_SVC_CSS_SELF_REG_B2C_AUTO_APPROVE for B2C requests.

Here's the expected result:

• The user account in IDCS with the Customer Self-Service User job role (or job role given by profile option
SVC_CSS_USER_ROLE_COMMON_NAME) will be present.

• The contact in Fusion Service, stamped with the GUID of the user account in IDCS.

• The contact is given the Self-Service User role.

• If the request was of the Fusion type:

◦ A relationship between the business account and the contact is indicated.

◦ If the user is the first user of a business account the user is given the Customer Self-Service Account
Administrator job role (or a job role given by the SVC_CSS_ACCT_ADMIN_ROLE_COMMON_NAME profile
option).

The primary attributes that influence the Self-Service registration are:

• Request Type Code (RequestTypeCd). If this attribute is absent in the request payload or if the value of
this attribute is ORA_CSS_REQ_TYPE_CONTACT then its a Fusion request. If the value of this attribute is
ORA_CSS_REQ_TYPE_CONSUMER then it's a B2C request.

• Account Key (AccountKey). For Fusion requests, this attribute is expected to identify a unique business account.
The profile option SVC_CSS_ACCT_KEY_FIELD determines the attribute of the Account object whose value
must be the specified account key value. The default value of this profile option is OrganizationName but it can
be set to any attribute of the account object whose value is unique to a single account.

• Email Address (EmailAddress). This attribute is the default value of the SVC_CSS_REG_FLD_CONTACT profile
option and is used to locate an existing contact. You can set this profile option to any attribute on the Self-
Service Registration object. The corresponding attribute on the Contact object is located either using auto
mapping logic or using the value of the SVC_CSS_REG_CONT_MAP profile option. The email address of the
located contact and the email address of the registration request must be the same.

• Login ID (LoginId). If a value for this attribute isn't specified, the value will be set to the value of the attribute
identified by the SVC_CSS_SIGN_IN_ATTR_NAME profile option whose default value is EmailAddress. Login ID
is used to locate a user account in the Identity database.

The following table shows the actions taken based on the result of searching for existing contact and user account:

Search Result Action

Contact doesn't exist but the user account
exists.
 

A contact record is created and the GUID of the user account is stamped on the contact if the user
submitting the registration request is authenticated by IDCS or the user submitting the registration
request has been given the Associate User With Contact privilege. The Associate User With Contact
privilege is given by default only to users with the Customer Self-Service Administration duty role.
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Search Result Action

Contact exists and the user exists and
contact record isn't stamped with the GUID
of the user account.
 

The GUID of the user is stamped on the contact provided the user submitting the registration request
is authenticated by IDCS and the email address of the user account is same as that of the registration
request or the user submitting the registration request has been given the Associate User With Contact
privilege.
 

Contact exists and the user exists and
contact record is stamped with the GUID of
the user account.
 

If this is a Fusion request, the user already has a self-service user role for one account and is granted
the self-service role for another account.
 

Contact exists but user account isn't
found.
 

A user account is created and the contact is stamped with the GUID of the user account.
 

Neither a contact nor a user account is
found
 

The records are created and the contact record is stamped with GUID of the user account.
 

After the contact record is created, the attributes of the Self-Service Registration object are copied over to the Contact
object. If the name of an attribute of the SelfRegistration object (ignoring _c) is same as that of the Contact object then
the value of that attribute is copied over. If the names aren't the same then the SVC_CSS_REG_CONT_MAP profile
option can be used to map an attribute of the SelfRegistration object to an attribute of the Contact object.

How do I configure Installed Base Assets?  
Here's the configuration steps you must perform to make Fusion products manageable as Installed Base Assets.

The Digital Customer Service product picker, by default, shows all products flagged as Enabled for Customer Self
Service. You must set an additional property in Fusion Service to enable a product to be managed as an Installed Base
Asset.

1. Sign in to Fusion Service as an administrator or setup user.
2. From the home page, select Product Management, then click the Product Information Management tile.
3. Click the Tasks drawer icon, and then click the Manage Items link.

The Manage Items form appears.
4. Perform a search for your product, then, in the search results, select the link for the product.
5. In the product detail page, select the Specifications tab, then from the Item Organization list, select Service.
6. Update the products to make them manageable as Installed Base Assets, locate the Assets area of the view,

and do one of the following:

a. Click the Enable Asset Tracking drop down list and select: Full Lifecycle.
b. Or, click the Enable Asset Maintenance drop down list, and select Yes.
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How do I enable automatic Sign in for authenticated
Identity Cloud Service users?  
You can configure your custom sign-in page in the Digital Customer Service application to automatically log in users
who are already authenticated through Identity Cloud Service.

Users can be authenticated either directly through the IDCS administration console, or through another application that
uses the same IDCS instance as the Digital Customer Service application. This functionality is disabled by default, but
can be enabled by setting the enableAutoLogin constant in the new LoginAuthenticatedIdcsUser application level
action chain to true.

Here's how you do it:

1. In Visual Builder, click your application icon in the Web Apps navigator.
2. Click the Actions tab.
3. In the list of Actions, locate and select the LoginAuthenticatedIdcsUser action.
4. Set the default value of the enableAutoLogin constant to true.

What are the Installed Base Asset components?  
If you're an Oracle Cloud customer that uses Installed Base Assets for processes such as Supply Chain, Service
Logistics, Service Contracts, or IOT, you can opt-in to use the same asset model for your service request and work order
processes.

Your users can register products as installed base assets using the asset-register flow in the Digital Customer Service
reference implementation. Users access the flow by clicking the Register Product button on the Registered Products
view. You can only register products that have been configured to allow tracking as assets.

Note:  Assets and product registrations are Oracle Fusion Installed Base Assets.

Account managers can view and manage all assets associated with the account that they manage. Non-account
manager users can only access and manage assets that they have registered themselves.

Users can do the following with registered products:

• View a list of product assets

• Register a product asset

• View the details of a product asset

• Update the product asset description

• See knowledge articles associated with a product asset

• See service requests logged against a product asset

• Create a new service request against a product asset from the product asset details page

Users access the list of registered products by clicking the Settings and Actions menu, and selecting the Registered
Products option from the drop-down list.
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The following table describes components specific to asset registration.

Component Name Description

Asset List
 

Lists the Installed Base Assets of Digital Customer Service self-service users. Users can register
products as installed base assets using the asset-register flow in the Digital Customer Service
Reference Implementation, by clicking the Register Product button on the Registered Products flow.
Only products that have been configured to be tracked as assets can be registered.
 

Asset Register
 

Enables a self-service user to register an Installed Base Asset in the Digital Customer Service
application.
 

Asset Detail
 

Enables a self-service user to view details and update the description of the registration of an Installed
Base Asset in the Digital Customer Service application.
 

How Digital Customer Service User Roles are Used by the Installed Base
Asset Components
Your users can register products as installed base assets using the asset-register flow in the Digital Customer Service
reference implementation. Users access the flow by clicking the Register Product button on the Registered Products
view. You can only register products that have been configured to allow tracking as assets.

Here's a list of the roles required for registering products and what each role can do:

Role Definition

Account Manager
 

Can view and manage all assets associated with the account being managed.
 

Non-Account Manager User
 

Can only access and manage assets that they have registered.
 

B2C User
 

Can register and manage assets.
 

How do I activate Digital Customer Service as a new
customer?  
To perform this step you must have the Service Administrator role. The Service Administrator receives the "Action
Required" welcome email from Oracle. As the designated activator of the Oracle Digital Customer Service service, the
activator is only required to activate Digital Customer Service.

After that, the activator can select a different service administrator to manage the day-to-day administration of the
service during the activation process if necessary.

1. Open the email prefaced "Action Required" that you received from Oracle Cloud.
2. Review the information about your service in the email, and then click the provided link to activate your service.
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3. In the Activate My Service form, do the following:

a. Enter a cloud account name.

This name is used to identify your cloud account. We recommend that you use the same Oracle Cloud
account that Fusion Service resides in.

b. Enter Administrator details, and if you're not going to be the Service Administrator going forward, assign
the new Service Administrator now.

4. Click Create Account to proceed to submit your request.
5. Click Close.

The account is now active and ready to use.
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